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ABSTRACT 

 

 

Pakistan is facing severe electricity crisis over a decade. Electricity demand is 

being met through expensive energy resources like thermal energy instead of 

renewable resources like hydropower. Every year sufficient amount of water is 

flowing into sea without being effectively utilized. Along with this, a lot of potential 

sites are available where flows are available in abundance. Need of time is that to 

harness more and more hydropower sites. Special measures should be taken for 

conserving water which will be helpful not only for electricity generation but for other 

purposes also. By utilizing all available water resources in an optimized manner, 

electricity crisis can be managed to some extent at low price as compared to 

electricity produced by other expensive energy resources. 

 

WAPDA has identified a lot of hydropower projects in northern areas. 

Nasirabad hydropower project is one of them. It has been identified in Gilgit 

Baltistan. WAPDA has identified this project as a run of river project with installed 

capacity of 15 MW utilizing two number of turbines. This study was carried out to 

make Nasirabad hydropower project most feasible in terms of power and energy as 

well as cost effective generating more revenue. For this purpose, two alternatives of 

peaking and continuous operation were selected. Nasirabad Hydropower Project was 

assumed to run as a peaking (for 4 peak hours operation and 20 off-peak hours 

operation) as well as a continuous (for 24 hours operation) run of river plant to get 

optimum results. Energy output was found out by SIMAHPP and by developing 

spreadsheet model for both alternatives. 
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Annual energy output 235.15 GWh for peaking and continuous operation was 

same using SIMAHPP. But revenue generated for peaking operation is 1120.91 

Million rupees which is more than the revenue generated for continuous operation i.e. 

1034.69 Million rupees. Revenue was computed by introducing cost per KWh for 

peak and off-peak hours. SIMAHPP simulates only for one turbine. Project working 

as a continuous operation dropped off on the basis of less revenue generated. 

 

Computation of energy using spreadsheet model for one turbine was also 

carried out. Annual energy computed for both alternatives is almost same. But 

breakdown of total annual energy into peak and off-peak energy showed that peak 

energy produced in peaking operation is more than the peak energy produced in 

continuous operation (by providing some storage upstream to store flows to be 

utilized in peak hours). On this basis, annual revenue computed is 1106 Million 

rupees for peaking operation which is more than the revenue computed for continuous 

operation i.e. 1086.20 Million rupees. In this method, continuous operation was 

dropped off due to less revenue generated as compared to revenue generated in 

peaking operation. 

 

Comparison of both studies considering only the peaking plant operation was 

carried out which showed same results for both studies. To increase the output of 

project, it was decided to increase design discharge with increased number of 

turbines. The purpose behind this was to utilize sufficient available flows throughout 

the year. SIMAHPP gives results for only one turbine. But in spreadsheet model, 

computations can be made for number of turbines.  

 

Finally, project was optimized with increased design discharge working as a 

peaking plant for 4 peak hours operation in combination with continuous plant 
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working for 20 off-peak hours. In this case, energy output was 645.80 GWh with 

installed capacity of 119 MW generating additional 117.50 Million rupees revenue 

than continuous system operation with same number of turbines. For peaking system, 

2.84 million m3 amount of storage was required to store extra flows which will be 

utilized in peak hours. Required storage of reservoir was calculated using the area-

elevation-volume relationship at elevation 2046 meters. Plan and sections of proposed 

reservoir area were drawn with the help of contour map of Nasirabad Hydropower 

Project by using Auto-Cad. 
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Chapter I 

INTRODUCTION 

 

1.1 GENERAL 

Power can be produced by exploiting different natural resources. Out of these, 

hydropower is economical source of energy. Hydropower is generated by converting 

potential and kinetic energy of water by electromechanical means. Hydropower plays 

very important role in country’s development as it is renewable, non-polluting, 

reliable, flexible and oldest source of energy. It can be key to self-reliance because of 

being completely national resources. It also helps to reduce dependence on imported 

fuel (WAPDA, 2000). 

 

Keeping in view the present scenario of energy crisis, it is highly desirable to 

exploit water resources judiciously. Efforts should be made to maximize energy 

output of existing hydropower projects as well as installing new hydel schemes. 

Energy demand increases in summer as compared to winter season. However, demand 

criteria for northern areas are quite different from rest of Pakistan. In these areas, 

demand increases in winter season. Also, variation of demand occurs in peak hours 

daily in morning and evening. Power demand may be classified as peak and off-peak 

hours. 

 The peak demand may occur in morning or evening for four hours. 

 The off-peak demand consists of remaining twenty hours.  

 

WAPDA supplies its peak demand by combination of thermal and hydropower 

energy in peak hours. If this demand is met through hydropower, it will give not only 

cheap energy and also hydro generators can be brought on line rapidly in well-

organized manner (Hussain, 2005). 
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  The demand for electricity is increasing day by day. Independent Power 

Producers (IPP’s) has played an important role in country’s development however 

power cost has also been increased significantly that is going to beyond the common 

man capacity. For cheap energy production, hydropower is a feasible option by 

storage of water. There are abundant water resources in Pakistan but during last 21 

years, the share of hydropower production has come down from 60 % to 34 % of total 

power generation (WAPDA, 2004). 

 

 

  The best utilization of available water resources in Pakistan can lead to a self-

sufficient country in power sector development. Hydropower is a non-polluting 

renewable source of energy. Pakistan’s power shortages are being met with thermal 

energy as an alternative of hydropower. To meet energy crisis, our dependence on 

thermal energy has caused an extreme increase in tariff. Therefore, hydropower is an 

optimal choice to meet this severe energy demand (WAPDA, 2004). 

 

1.2 PROJECT DESCRIPTION  

It is great blessing for any country to have abundant water and power 

resources. Pakistan is one of these blessed countries and have great potential to utilize 

these resources. These resources are largely available in the northern areas of 

Pakistan. In Gilgit Baltistan, almost 278 project locations have been identified having 

total capacity of 21125 MW with varying heads i.e. high, medium and small heads. 

Nasirabad HPP is one of these projects. It is located on Hunza river and considers 

short-cutting various turns made by the river between its confluence with Hassanabad 

nullah and Nasirabad village. The project comprises of weir, head race tunnel, surge 
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tank, penstock, power house, and tail race. (WAPDA, 2000). This study is carried out 

to maximize the energy output by operating the units as a peaking plant in 

combination with continuous operation for supplying the energy during peak hours at 

cheap rate. Also, to provide the storage upstream of the weir to store abundant flows 

available throughout the year for maximum utilization of available flows. 

 

1.2.1 Location  

The project area is located on Hunza River and considers short cutting various 

turns made by the river between its confluence with Hassanabad nullah and Nasirabad 

village. Latitude and longitude of weir site are 36°-17’-34” and 74°-37’-15” 

respectively. Power house site is located 36° 15’-20” N and 74°-33’00” E. 

 

1.2.2 Accessibility  

The project area is accessible from Gilgit by Karakoram Highways. The weir 

intake and power house site are located along K.K.H. 

 

1.2.3 Hydrology 

The catchment area of Hunza River up to the intake site is estimated to be 

about 11656 km². Mean annual minimum flow is 26.46m³/s. Flow availability 90% of 

year 28.26 m³/s. Return period of 100year flood is 4367 m³/s. 

 

1.2.4 Multi-Purpose Use of Water  

There are no irrigation canals off-taking in the proposed project area. 
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Source: Google Earth 

Figure 1.1 Proposed Layout of Site 
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1.2.5 Geology of Proposed Structures 

The geological conditions seem to be favorable for the proposed hydel 

scheme. However, some problem like seepage and rock out breaks are expected 

during the excavation of tunnel hence extensive protective measures are required. 

 

1.2.6 Description of Project Components 

A brief description about main components of the scheme is given below 

(WAPDA, 2000): 

 

1.2.6.1 Weir and Intake 

The intake site is located just downstream of Hassanabad nullah with Hunza 

River, where a bridge of the road to Sumayar village crosses Hunza River. River 

width at the site is approximately 100 meters, for which a weir with lateral intake is 

being proposed. 

 

1.2.6.2 Gravel Spill and Sand trap 

Due to space limitations, gravel spill structure and sand trap will have to be 

constructed underground. Keeping in view the sediment load of Hunza river in this 

area, the size and associated cost of these structures may play an important role in the 

determination of the design discharge for this project. 

 

1.2.6.3 Head Race Tunnel 

The head race tunnel is proposed on right bank of the river, having about 

7000-meter length. The tunnel alignment can be made in such a way that various adits 

are possible to allow the construction of the tunnel. The tunnel will be below the level 

of KKH throughout, which may simplify investigation and construction works. 
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1.2.6.4 Surge Tank 

A surge tank is proposed near a turn made by KKH near village Nasirabad. 

 

1.2.6.5 Penstock 

Two number supported steel pipe of 1940 mm diameter, with 150 m total 

length of each is proposed in about 30° terrain slopes. 

 

1.2.6.6 Power House 

An external type power house at elevation 2120 m.a.s.l is proposed on a 

terrace on right bank of Hunza river. Two Francis type turbine generator equipped are 

recommended. 

 

1.2.6.7 Tail Race 

A rectangular tail race canal of 30 m length is proposed. The canal should 

discharge the flows into Hunza River. 

 

1.2.6.8 Salient Features 

Following are salient features as shown in Table 1.1. 

 

Table 1.1  Salient Features 

Sr. No. Design Feature Design Data 

1 Design Capacity (P) 15 MW 

2 Design Discharge (Q) 26 m³/s 

3 Gross Head (H) 80 m 

4 Head Race Length 7000 m 

5 Tail Race Length 30 m 

6 Type of Project High Head, Run-Of River 
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1.3 PROBLEM STATEMENT 

Hunza region is in the grip of severe climate where temperature varies 

between -20 to 45ºC. the area is completely black out during winter season due to low 

flow in the streams. The demand of electricity during winter is high as opposed to 

down country. The demand during morning and evening is very high. The area is 

abundant of hydropower potential. The GB Govt. has planned number of hydropower 

projects in Hunza valley and surroundings. One of these projects, Nasirabad 

hydropower project of 15 MW have been identified on Hunza river as a run of river 

scheme. In this study, a research will be undertaken to use of hydropower potential at 

optimized level. By designing the project for peaking mode, the demand at peak can 

be met and potential could be used otherwise there is huge loss of power, if not 

exploited.  

 

The present scarcity of fuel oil and its highly increasing prices has made it 

difficult to use the fuel oil for power generation purposes. The cheapest renewable 

natural resource is the hydel energy. This natural source is in abundance in Pakistan 

and needs to be exploited. The exploitation of natural resources will help to meet the 

growing power demand of Gilgit-Baltistan. The contribution of hydel power 

generation into Regional Grid being cheap energy resource will help to reduce the 

tariff.  

 

Electricity demand varies throughout the day which can be divided into peak 

hours and off-peak hours. Usually, peak hours are considered two hours in the 

morning i.e. from 07:00 am to 09:00 am and two hours in the evening i.e. from 07:00 

pm to 09:00 pm or total four hours in the evening from 07:00 pm to 11:00 pm. During 
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peak hours the thermal energy is used. If this demand is met through hydropower, the 

cost can be reduced. Tarbela, Mangla and Ghazi Barotha are operating as peaking 

hydropower plants in Pakistan and thus reducing the cost of electricity. 

 

1.4 OBJECTIVES 

Followings are the objectives of the study: 

 To determine the energy output of project under peaking and continuous flow 

conditions using software SIMAHPP. 

 To develop a methodology to compute power production considering the 

power house functioning as peaking system as well as continuous system. 

 Computation of reservoir volume for the storage of extra flows to be used in 

peak hours i.e. peak flows. 

 

1.5 SIMAHPP 

SIMAHPP (Simulation and Assessment of Feasibility of Hydropower 

Projects) is windows based software. It is designed to model the project and to 

evaluate that either the hydropower projects are economically feasible or not. It is 

designed to work out a lot of challenges including determination of design discharges 

and selection of appropriate water turbines. Simulation can be carried out for small 

hydropower projects to mega hydropower projects as well as for single site to 

multiple sites. Results can be obtained in the form of detailed project characteristics. 

Results are presented in tabular and graphical form on the basis of three main input 

parameters including hydraulic, financial and environmental (Environmental-expert, 

2010).  
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It gives multi criteria project evaluation which is described below: 

 

1.5.1 Hydraulic Evaluation 

Technically, it helps to calculate: 

 Design discharge 

 Power for the effectiveness of a system  

 Optimized Power Production by utilizing optimal system operation period. 

 Suitable selection of unit for the modeled hydropower system. 

 

1.5.2 Financial Evaluation 

Feasibility of any project on the basis of simulation results can be determined 

using SIMAHPP 

 Investment costs 

 Annually or monthly Amortization rate  

 Payback period 

 Investment costs according to system volume. 

 Carbon market turnover. 

 

1.5.3 Environmental Evaluation 

With the increase of global warming, hydropower projects are helpful in 

reduction of carbon dioxide quantity being a renewable energy source. In generation 

of same quantity of energy, hydropower projects release less amount of carbon 

dioxide as compared to other non-renewable sources such as coal and natural gas.  

Keeping in view the environmental factors, this software will be helpful to see that 

what is the role of planned hydropower projects in the global warming reduction 

(HYDRO XPERT, 2010) 
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1.6 UTILIZATION OF RESEARCH 

In this research, it will be demonstrated that peak hour plants are need of the 

time both for economical point of view and meeting demand during peak hours. As 

the cost per unit during peak time is high. So, more revenue can be generated which 

can be based for further development of HPP’s in the region. Further, cheap energy 

utilization during peak hours will also replace expensive thermal energy production. 

Later on, at any stage these power projects can be connected to National grid which 

will give additional benefit.  
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Chapter II 

LITERATURE REVIEW 

 

Pakistan is facing intense energy crisis at present. All possible efforts should 

be made in order to improve the capacity of energy production. This could only be 

possible by identifying and exploring more sites and more water and power resources. 

The installation of peaking facility in any project is the need of time to supply secure, 

dependable, continuous and cheap hydropower energy.  

 

In Pakistan, during peak hours energy is supplied from thermal generation 

which is expensive. Hydel power stations do not provide continuous supply 

throughout the year depending upon the availability of flows. It ultimately leads to 

demand for thermal energy in peak hours. Although hydropower projects take time in 

development but they produce energy at a very low rate (WAPDA, 2012). 

 

Keeping in view these requirements projects are being planned to work as 

peak hour plants by increasing the stored capacity at fore bay or reservoir. 

Furthermore, projects are being optimized to get most efficient system in hand. By 

optimization, enhanced energy output can be obtained at optimum cost. 

 

2.1 PEAKING PLANTS 

Peaking power plants generally run only when there is a high demand, known 

as peak demand for electricity. Because they supply power only for short period. The 

power supplied in this period at a much higher price per kilowatt hour than continuous 

power. Peak load power plants are used in combination with continuous power plant, 

http://en.wikipedia.org/wiki/Base_load_power_plant
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which supply a reliable and constant amount of electricity, meeting the minimum 

demand (Wikipedia.org/peaking power plant). 

 

2.2 OPTIMIZATION 

It can be defined as, “taking decision or to design a plant most efficient as 

possible”. In case of hydropower, optimization is carried out to obtain desired results 

by utilizing minimum water consumption (Curtiss et al, 2012). Maximum benefits can 

be obtained from a project in terms of cost and power generation using different 

optimization techniques. Optimum design of hydropower project by increasing power 

output and reducing cost by making it economical is known for a long time. But due 

to complexity of hydropower project and its optimization model, it is difficult to carry 

out its complete utilization. Various studies have been carried out for the optimization 

of high head (run of river) hydropower projects. Different alternatives may be adopted 

for optimization. Best suited components of hydropower plant can be obtained by 

applying optimization technique. Similarly, best layout of plant is achieved. 

Optimization is carried out to solve complex problem in hydropower. It can be done 

by analytically, graphically or mathematically. Software may also be used for this 

purpose. 

 

2.3 BENEFITS OF OPTIMIZATION 

By using different optimization techniques, following benefits can be 

obtained: 

 Most economical hydropower plant/project 

 Maximization of energy output 

 Improved performance of units/components of plant 
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 Enhanced / augmented service life of components / equipment 

 Optimum design of a plant 

 Reducing power losses 

 To maximize the value of water resources 

 

2.4 TYPES OF OPTIMIZATION 

Chief of Engineers, U.S. Army or (USACE) and other American federal 

agencies defined following types of optimization related to hydropower in the 1980s. 

1. Improved system of a single unit regarding energy generation for available 

flow with same head. 

2.  Synchronization of turbines to obtain a powerhouse production set point 

utilizing the minimum discharge. The enhanced performance of the system at 

this phase is attained by selection of the most excellent feasible turbine and 

load sharing. 

3. Synchronization of all the storage reservoirs and powerhouses in a catchment 

area/water basin. 

4. Synchronization of several catchment areas in a specific terrain or locality. 

5. Synchronization of several renewable resources in an area. (Curtiss et al, 

2012) 

 

2.5 OPTIMIZATION TECHNIQUES 

To carry out optimization, a large no. of techniques and software are available. 

These techniques can be applied to hydropower generation, flood control, water 

supply and irrigation. Some techniques are described below: 

  



14 
 

2.5.1 Decision Support System 

It suggests rapidly how to exploit hydropower benefits while interacting non-

energy features of water management e.g. special effects on the river downstream and 

on the fore bay upstream.  The components of decision support systems Depend on 

how quickly specific judgment must be made. Figure 2.1 shows the components of a 

comprehensive decision support system developed by Charles Howard & Associates 

Ltd. for operations and for planning. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2.1 Components of a Comprehensive Hydroelectric DSS 

 

While carrying out the investigation/research of a hydropower plant/ 

facility, DSS gives guarantee of utilizing the finest available information (facts and 

figures) that confines the most benefits. With a well-designed decision support 

system, this objective can be accomplished. Guidance for new trainer can be obtained 

from software even when some changes occur in operating settings. Decision support 

systems presently in operation comprise single generating stations, cascades of dams, 

and difficult river networks. 
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The components of decision support system are different for each hydropower 

system showing different priorities and forecasted benefits and costs. Decision 

support systems are unique for one specific site (Howard, 2006). 

 

2.5.2 Particle Swarm Optimization 

Nowadays, this method is very popular in research fields. Application of this 

method is somewhat a new technique. Best design in terms of benefit and cost ratio is 

obtained for hydropower plants by using this method. Benefit cost ratio was 

determined by taking into consideration multiple cost parameters and turnover 

production of HPP. The result was greater than one making it economically feasible 

for hydropower projects. This is required criteria for making any hydropower project 

feasible that benefit cost ratio should be greater than one. Direct costs and turnover 

obtained were the basis in analyzing the benefit cost ratio. Nevertheless, attention was 

not paid to other advantages (Rahi et al, 2011). 

 

Selection of several turbines is carried out randomly among the total available 

turbines for specific purpose. Further, detailed selection of units is made arbitrarily. 

The load sharing algorithm can be executed only in the case, if the available power is 

greater than or equivalent to the required power. The algorithm reiterates again and 

again. As a result of this iteration, the optimum turbine is chosen and load sharing 

output is selected. To get the most reliable results, a number of iterations has to be 

performed. Moreover, with this method, choice of units can be improved which 

ultimately leads to the best output (Curtiss et al, 2012). 
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2.5.3 Stochastic Dynamic Programming (SDP) 

Two steps are performed in this method: 

1. Discretized the Inflow and Reservoir Storage: for same time frame, influx 

have been divided into number of non-continuous intervals starting from 

minimum to maximum. An observation was made for this influx series. The 

probability of inflow interval i (during time period t) to inflow j (during time 

period t + 1) is computed.  

2. To Investigate the best proposal: By using Equation  

 F(Si,Ii,Ii+1…..Ii+n) = max Bi(Si,Ri)+Ei+1(f(Si+1,Ii+1,Ii+2…….Ii+n)) 

The best proposal is determined by utilizing this equation and making it 

best operational measures. Following are the measures used in research. 

Vt + 1 = D(Vt, It) 

Where t is the reservoir volume required to choose, and Vt and It are the present 

reservoir volume and influx. This model is used for hydropower generation (Mythili 

et al, 2013). 

 

2.5.4 Lowest Peak Efficiency Dropping for Unit Selection 

In this process, peak efficiency is the basic criterion in selecting the turbines. 

Units having lowest peak efficiency are dropped off. Load sharing is find out and 

evaluated to the former findings. Similarly, units having low efficiency are being 

dozed off, unless the power requirement is not obtained by utilizing the producing 

units and units having high efficiency are selected as a result of this method. To find 

an optimum approach, the computer algorithm takes no time for any given setpoint in 

a 10- turbine powerhouse, with an accuracy margin of 0.5% (Curtiss et al, 2012). 
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2.6 RELATED WORK 

By using an alternative layout of a project and optimization technique, 

Robertson (2009) enhanced the power generation of Aberfeldie Hydropower project 

up to 25 MW. This project was constructed in 1922 with generating capacity of 5 

MW. The project was optimized for 20, 25 and 30 MW. The optimization technique 

was implemented for selection of optimized diameter of low pressure tunnels in the 

waterways of project for each capacity. The objective was to get the pipe diameter 

with maximum benefit to cost ratio. Optimization for high pressure tunnels was also 

performed. The results showed that the most economical diameter found for high 

pressure tunnels was 1m. This economical diameter for high pressure tunnels   was 

less as compared to diameter for low pressure tunnels. Later, optimization for number 

of turbine units was carried out. Several combinations of turbine units were taken. 

Two identical turbines, three identical turbines, four identical turbines, and two 

identical turbines having same capacity with one different unit having less capacity 

and two turbine units having different capacities were selected for evaluation. 

Conclusion was that the optimization of project can be carried out with varying 

potential energy from 20 megawatts to 30 megawatts. For improved and enhanced 

system of project up to 25 megawatts, three numbers of turbine units having same 

capacity were chosen. Type of turbine was horizontal Francis. Its enhanced mean 

annual energy was 105 Giga Watt hours which was previously 34 Giga Watt hours. 

After improving the system, Plant Factor reached up to 48%. 

 

Leon (2014) performed Dimensionless analysis for hydropower projects. In 

this analysis, optimum flow and diameter of penstock was determined for two types of 

turbines i.e. impulse and reaction turbines. The aim was to produce hydropower 
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energy by minimizing water consumption. Various relationships were established 

among power, energy, discharge and losses to develop number of dimensionless 

equations. Further, by combining these equations optimal discharge and penstock 

diameter were determined. The conclusion was made to reduce water utilization as 

minimum as possible, gross head and net head ratio must not be greater than 15%.  

 

For a specific flow rate, increase in energy losses and water velocity occurs 

with the decrease in diameter of pipe. This happens because friction is a function of 

velocity.  With the increase in velocity, friction also increases. Yet, increase in 

diameter of pipe would result a drop-in velocity as well as a decrease in friction (head 

loss). But there is a significant increase in the price of pipe with the increase in 

diameter of pipe. The method adopted for penstock design and penstock sizing will be 

helpful to maintain equilibrium between energy loss and diameter of pipe, material of 

pipe, and thickness of wall. For the preliminary design of penstock, proposal of 4 

ft/sec velocity is presented (McKinney et al, 1983). 

 

Mays (1999) determined the economically suitable penstock size. The most 

optimum diameter of penstock can be obtained by determining the total cost of 

construction and energy loss cost. By increasing the penstock diameter, the energy 

loss cost decreases but penstock cost will increase. Best penstock size can be decided 

by using the hit and trial method. 

 

Number of factors e.g. flows, head, and plant capacity involve in the turbine 

selection of hydropower projects. In the process of selecting type of turbines, focusing 

on the appropriate number of units, setting of center line, specific speed, size of 
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runner and elevation of center line of turbine is the primary purpose of this process. 

Two fundamental methods are usually used for selection of turbines (1) By discharge 

and head (2) On the basis of specific speed. For turbine selection, standard graphical 

charts are followed. While selecting the turbines, not only technical but economic and 

socio environmental factors must be taken into account (Sangal et al, 2013). 

 

Using the least number of turbines for any project is economical. It is 

expedient to use several units when flows are available in abundance. Normally, 

preference is given to same capacity turbines when several units are being utilized. 

While choosing optimal units, different options are considered for one unit, two or 

more than two units of same capacity and multiple units of different capacities. 

Suitable number of turbines can also be selected by analyzing the flow duration curve. 

Different methods are adopted for turbine selection (WARNICK et al, 1984). 

 

In the demonstration of Monograph No.20 of USBR (1976), it is 

recommended that while selecting turbines, care should be taken in this regard that 

units can be operated efficiently when there is a varying flow. The turbines should be 

manufacture in this way to comply varying discharge series. During process of 

selecting turbines, precise investigation of necessary data is carried out. Necessary 

data consists of availability of flow data, how reservoir is operated and field data. The 

cost of hydropower plant is dependent on the number of units. Efficiency of turbines 

can be increased by using several turbines. 

 

A dynamic programming model was developed for Itaipu hydroelectric 

project. Its planning and designing was carried out in such a manner that generation 
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by generating units can be optimized in the highly lucrative way. The location of this 

project is in south of America on Parana River. Its generation capacity is 12.6 Giga 

Watt Hours. 18 number of turbines are installed with same capacity of 700 megawatt 

each. The total plant efficiency is affected to a great extent by utilizing several 

turbines and generator units. By optimal generation of turbine units, millions of 

dollars can be obtained every year in terms of direct cost benefits (Arce et al, 2002). 

 

Tuhtan (2007) carried out cost optimization of small hydropower projects for 

the case study of Neumuhle, Southern Germany. The electricity demand increases as 

world economy increases. Keeping in view the future possible energy sources, 

hydropower has multiple advantages. It is most efficient, low annual maintenance cost 

and its life span is long. Developed countries have exploited large scale hydropower 

potential whereas in developing countries a large-scale hydropower development is 

still required. However, small hydropower development is still required in developed 

as well as developing countries. In construction of small hydropower project, its high 

initial investment cost is the biggest economic challenge in comparison of fossil fuel 

sources. By providing limited set of site specific data, best suited design components 

of small hydropower can be obtained at initial stage. After this optimization, to set the 

boundaries of the cost uncertainty of four costing groups and the calculated net 

present value of the project, stochastic simulation is used. RETScreen formulae-based 

costing method for four cost categories was used. In the first step, the assessment of 

suitability of adopting this method was carried out. After this, the NPV was figured 

out for a 30-year design life and making it efficient by utilizing a continuous Genetic 

Algorithm. Stochastic simulations were performed using the Monte Carlo method. In 

this simulation, comparison was carried out between the anticipated prefeasibility cost 



21 
 

accuracy and the results of research. While analyzing the cost, it was determined that 

the early accuracy of the costing equation had the greatest effect on the results. 

Moreover, a comparison was carried out between efficient optimal design and initial 

evaluation in finding out the initial values of flow rate and operating head. As a result 

of this comparison, performance of optimal design was very well.  

 

Hermida (2013) carried out research by using an optimization technique to 

determine the best operation of a reservoir with both regulated and non-regulated 

hydro power plants. The proposal for computing the best energy bids of a set of 

hydropower plants in a reservoir was presented as an optimization problem. The 

operation was planned for the short duration i.e. 24-Hour, the application of model 

was applied to a real Spanish reservoir. The requirements of environmental flows and 

social uses for the real operation were considered by the algorithm. By considering 

both of these requirements, the assessment of economic weight of these requirements 

was performed by this program in the management of resources. Without direct 

control abilities, out of these, one hydro plant was run of river. Along with this, the 

operation of hydro power plants was modified. It was observed in the results that the 

run of river plant can be effectively regulated by utilizing the storages of the other 

plants which are not fluent. Social consumption costs were found more significant in 

simulations as compared to the environmental conditions. An estimation was carried 

out for the charges to be incurred for provision of water for social use. The generation 

of maximum profitable electricity in the daily power market was calculated by this 

method keeping in view the environmental restrictions and provision of water for 

community. The algorithm proposed can easily be stretched to account for different 

operative limitations on the hydro systems. 
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Due to high price of electricity during peak hours i.e. from 1900 hrs. to 2200 

hrs., industrial customers try to find other optimum solutions such as independent 

power supplies. Customers don’t rely only on the power supplied by the grid. An 

optimum solution was found out for a mill where paper recycling was carried out. 

This mill aimed to carry out its working even during peak hours. The location of mill 

is in Rio Grande do Sul, in southern Brazil. In this mill, PV module, a set of diesel 

generator and a micro hydropower plant are considered to be used. Study was carried 

out for two number micro hydropower plants. One plant had to be rehabilitated and 

other one had to be completely equipped with tools. Homer software was executed to 

find out the highly appropriate set of components. The result was excessive sale of 

electricity to the grid. It looked significant to the feasibility of these alternate options 

that were not built exclusively on diesel generator. The optimum product comprises of 

a set of diesel generators and micro hydropower plants as a first alternative. While as 

another alternative, only one hydropower plant was considered. By a considerable 

penetration of PV modules, specific condition was that if there is 12% reduction in its 

present value, selling a total electricity equivalent to one that was purchased. As 

annual sufficient water is not available, first site demands to make up for this 

deficiency. However, in second alternative, this supplement is not required as annual 

water availability is abundant (Beluco et al, 2013). 

 

Fuzzy MCDM (Multi Criteria Decision Making) was used for selection of 

small optimal hydropower project. It is a multi-criteria optimization technique which 

offers a consistent procedure to categorize other options of natural energy sources by 

considering the various purposes and restrictions (Adhikary et al, 2015). 
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Turkey’s energy demand and its dependence on imported energy resources is 

mounting rapidly. In order to combat this energy challenge, efforts are being made to 

utilize the domestic renewable sources. Turkey has significant water resources. The 

main aim is to assess the hydropower capacity of the Zab River reservoir by using 

Geographic Information Systems and Remote Sensing methods which will be utilized 

ultimately for the development of country. SIMAHPP software was used to calculate 

the annual energy generation, installed capacity and estimated costs. Suitable 

locations for 12 dams in the basin were also determined with the help of SIMAHPP 

(Cabuk et al, 2013). 

 

Cine Dam will be constructed as a multipurpose dam. Electricity generation, 

to control floods and to fulfill irrigation requirements are its main purposes. It will be 

built on Cine stream. This stream is located at Buyuk Menderes River in Turkey. This 

stream has significant importance being an important bay of Buyuk Menderes River. 

The results of this research were compared by authors with other researches carried 

out by other organizations. Hydroelectric energy potential of the project was 

determined using the SIMAHPP 4 (Simulate and Assess the Feasibility of 

Hydropower Project). It is a professional software. The comparison of calculated 

hydroelectric potential by using SIMAHPP and power production worked out by 

other departments was carried out. The results of this comparison were same. The 

observed values of unit power, installed power, rated design discharge of units and 

energy production per annum were very close to the compared values. The power 

plant was planned using the data collected from the tributaries of last 43 years. This 

plant was planned with energy generation potential of 210.87 GWh/year. Its capacity 

was 48.14 MW. Its observed design discharge was 35 m3/sec. The water structures 
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have high costs as they will have to be operational for many years. So, for the safe 

operation during the service life of any project, analyzing the planning and design of 

any project should be carried out by using different computational methods. It will be 

helpful for the planning of the project (Koc et al, 2016). 

 

2.7 REVIEW OF PREVIOUS STUDIES 

2.7.1 GTZ Studies 

Location of Lawi Hydropower Project is approximately 40 km away from 

Chitral in the Khyber Pakhtunkhwa. Initially, Lawi HPP was harnessed and designed 

by German consultants in 2001 as a run-off- river project. On the upstream of dam, a 

little live storage was suggested which would be utilized for daily peaking. The total 

head 405 meter was determined from the intake structure to the site where 

powerhouse is located. In addition, an estimation was made that using this total head 

and chosen layout, potential energy of the powerhouse would be 65 megawatts. 

 

2.7.2 Feasibility Studies by HEPO (WAPDA)  

Hydroelectric Power Organization performed feasibility studies in 2007. A 

critical evaluation was done by this organization. They analyzed the project with 

power potential of 67.63 megawatts on Shishi River which is a stream of Chitral river 

on left bank. A total head of 413 meter was exploited and energy generation per 

annum was estimated approximately 295 Giga Watt Hours against 20 m³/sec flow. 

 

A proposal for concrete weir was given on Shishi river which is near Lao 

Nassar village. This weir will divert 20 m³/sec water to a headrace tunnel. Headrace 

tunnel will transport this flow to Lawi village. From here, flows can be carried down 
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to powerhouse through penstock. The water from powerhouse will be released to 

Chitral river through tailrace tunnel which will be concrete lined. 

 

“An analysis to find out best scheme layout, design flow, economical conduit 

size, size of surge shaft, Number and specifications of turbines for increasing the plant 

efficiency and energy against lowest possible cost for the final scheme layout can be 

carried out by feasibility study. Cost and economic parameters are basis of this study. 

To determine the dimensions of surge tank, Hydraulic Transient analysis was 

performed too. Installed capacity optimization criteria was critically evaluated for the 

progress of high head hydropower projects. During this evaluation, data of Lawi 

hydropower project was utilized performing the precise optimization with the help of 

worksheets, hydropower dimensioning and costing software (HPC) and AFT impulse 

(for optimal sizing of surge tank). An optimized potential of 69 megawatts, average 

energy of 297.90 Giga Watt hours per year, Plant factor of 49.33% with three 

numbers of vertical Pelton turbine units were recommended” (Haroon et al, 2005). 

 

2.8 EXAMPLES OF PEAKING OPERATION 

2.8.1 Duber Khwar HPP 

The Project is located in the District Kohistan of Khyber Pakhtunkhwa (KPK) 

of Pakistan on the river Duber Khwar, a right bank stream of Indus river. Access road 

is available to the project area Pattan. It is located 270 kilometers away from 

Rawalpindi and 300 kilometers from Peshawar. 

 

The enhanced power plant production is 130 megawatts. Its design flow is 29 

m³/sec at an average total head of 535 m attained from a channel which is 4873-meter 

long. The annual production of electricity is estimated as 595 GWh/annum will be the 
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peak energy. The firm capacity is 105 MW peak energy and firm capacity refers to the 

4-hour daily peak at 90% availability. 

 

2.8.2 Ghazi Barotha 

Ghazi Barotha may be referred to as a model for peaking hydropower plant. 

The 16.2 Mm³ storage at head pond allows storing extra water during off-peak hours 

thus increasing the head about 10-15 ft. The power demand is usually low during off-

peak hours, which is met with opening 2-3 units. Whereas the incoming discharges to 

the channel are more than the released discharges. So, the additional water coming in 

gets stored at the forebay. At peak demand hours, all the units are operated at their full 

capacity. At the end of peak, the forebay volume gets used and 2-3 units are shutdown 

with 2-3 operating. This way another cycle of filling of forebay starts and until next 

day peak hours it gets filled. Almost all the water gets stored at chashma reservoir 

from where irrigation water releases are regulated. 

 

2.8.3 Khan Khwar HPP 

The high-head hydropower development at Khan Khwar will provide 

cheaper hydropower. The project having an installed capacity of 72 MW 

corresponding to a designed maximum discharge of 35 m³/sec at 20% availability of 

flow.  Optimized annual energy generation will be 306 GWh out of which 105 GWh 

will be the peak energy. The firm capacity is 70.7 MW. This is a hydel scheme with a 

smaller reservoir. It will store water in the low discharge period for daily peaking 

operation.  Storage volume for four daily peak operation will be 400,000 m³. 
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2.8.4 Mangla Dam 

 Mangla Dam is also being used to supply peak power. All the units are run in 

peak hours to meet the demand. Whereas in off-peak hours, only 3-4 units are run 

accordingly with the discharge available. The extra water released during peak hours 

is collected and stored at Rasul Barrage. 

 

2.8.5 Tarbela Dam 

Tarbela Dam is being used to supply peak power with off-peak power 

generation as well. If provision of a large reservoir like Kalabagh is there downstream 

of Tarbela, then Tarbela can be run only in peak hours. Currently, the extra water 

released during peak hours is collected and stored at Ghazi Barrage. 

 

2.8.6 Allai Khawar HPP 

 The optimized maximum power output is 121 MW with designed discharge of 

21 m³/sec at 20% availability of flow throughout the year to utilize maximum 

available flows. The optimized project will produce 463 GWh annually. Out of which, 

160 GWh will be available during 4 hours/day during peak hours. The firm peak 

power available during these four hours is 81 MW annually.  
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Chapter III 

METHODOLOGY 

 

 

3.1 DATA COLLECTION 

The required hydrological and topographic data for optimization of Nasirabad 

hydropower project was collected from Hydro Planning Department of WAPDA 

(HEPO-WAPDA) and surface water hydrology project of WAPDA (SWHP-

WAPDA). Contour map of the site Nasirabad was also collected from Survey of 

Pakistan.  

 

3.2 DATA SYNTHESIS 

As there is no gauging station installed on Nasirabad to measure daily flows, 

no records of flows were available on site. To estimate the flows at site, daily flow 

data was obtained from the gauging station installed at Danyor bridge 46 kilometers 

downstream of the weir site. Historic daily flow records were available at Danyor 

bridge from year 1966 to 2004. After 2004, there was no flow data available due to 

earthquake of 2005 up to year 2013.  

 

To utilize this flow data, a relationship was developed for two sites i.e. Danyor 

bridge and Nasirabad site considering the catchment areas. The catchment area at 

Danyor was 13157 Km² and the catchment area of Hunza river up to the intake site 

was estimated to be about 11656 Km². Ratio of both areas was taken to develop the 

suitable relationship of discharge for both sites which is given below. 

Catchment Area at Danyor  = 13157 Km² 

Catchment Area at Nasirabad  = 11656 Km² 

Ratio of catchment areas  
=

11656

13157
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 = 0.89 

Q (Site) = 0.89Q (at Danyor) 

 

By using the above relation, daily discharge data at site of Nasirabad was 

computed from the available daily flow data of gauging station at Danyor bridge 

downstream of the project for the period of 39 years from 1966 to 2004. A graph was 

drawn to show the comparison of daily flows at both sites which is shown in 

following figure. 

 

 

Figure 3.1 Comparison of flows (1966-2004) 

 

 This daily discharge data was further processed to determine river inflow 

volumes on 10-daily, monthly and annual basis. Daily discharge data of each year was 

converted to mean 10-daily flows, mean monthly flows and mean annual flows. Daily 

discharge data for one average year was computed by computing the average monthly 

flows for each year considering the historic record of 39 years flow data. (Table 2 in 

Appendix A). Mean annual flows for available flow data were 293.68 m3/sec. Flow 
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duration curve was drawn to get the idea about the availability of flows throughout the 

year for an average year. (Figure 3.2).  

 

 

Figure 3.2 Flow Duration Curve (Mean Daily Flows 1966-2004)  

 

 

 

 

Figure 3.3 Average Monthly Synthesized Inflow (1966-2004) 
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Average monthly inflows at Nasirabad site were shown in figure 3.3 which 

showed the information that from May to September sufficient flows were available. 

Refer to mean monthly flows table 1 in Appendix A. 

 

3.3 OPTIMIZATION OF PROJECT 

Optimization of Nasirabad HPP was carried out to maximize the energy output 

of project using software SIMAHPP. In this software, simulation was carried out by 

entering the 12 entries of synthesized average monthly flow data for an average year 

of 39 years flow data. Refer to average monthly flows in appendix A. This flow data 

of 39 years at Danyor bridge was estimated for Nasirabad project using specific 

relationship. Average monthly flow data was entered as an input data. Gross head of 

Nasirabad site was 80 meters. Taking 2 meters as tail water head, net head of site was 

taken 78 meters. For financial information of Nasirabad HPP, assumed rate of 

electricity Rs.6/KWh for peak hours and Rs.4/KWh for off-peak hours was entered. 

Different rates for peak and off-peak hours were assumed because power supplied in 

peak hours commands a much higher price per kilo watt hour than power supplied 

during off-peak hours. 

 

All required design and cost parameters including gross head, tail water head, 

cost of electricity per kwh, operation per day depending on the availability of flow per 

day, inflation rate, VAT and other taxes values were also entered as an input data in 

software. All investment cost and other designed values are mainly dependent on head 

and flow data. All this process is shown in flow chart in Figure 3.4. Data entry screens 

and procedure can be seen in Appendix A. SIMAHPP was simulated considering the 
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different alternatives depending upon design time of operation which is as follows. 

Refer to Tables 4.1, 4.2 & 4.3. 

1. For 4-hours design time of operation to be operated as peaking plant in 

combination with 20 hours off-peaking continuous operation. 

 

2. For 24 hours design time of operation to be operated as continuous system. 

 

 

3.4 SIMAHPP DESCRIPTION 

SIMAHPP software designed to model and to determine the feasibility of 

hydropower projects. It is designed to work out a lot of challenges including 

determination of design discharge and selection of right water turbines. It is flexible in 

its operation. It can be executed for small to large hydropower projects. In addition to 

this, operation can be carried out not only for single site but for many sites. Flow chart 

for SIMAHPP is shown in figure 3.4. Technically, SIMAHPP computes power and 

energy with the help of following formulas on the basis of Flow Duration Curve and 

Hydrograph of available flows for given period of time. 

 

3.4.1 Power 

The power and energy were estimated on the basis of available average 

monthly flows data. The design capacity computed with following formula. 

 

Ρ =
η×g×Q×H

1000
      (3.1) 

Where 

P = Power in megawatts (MW) estimated from mean monthly discharge and 

corresponding head 

Q = Mean monthly discharge data Qd (m
3/s) 

H = Net head (meters) 
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Hydropower 

Project

Insert Data

Financial 
Parameters

Inflation rate PKR/KWh Cost other taxes

Output

Feasibility of 
Project

Hydraulic 
Parameters

Discharge 
(m3/sec)

Head (meters)

 = Combined efficiencies of turbine, generator, transformer  

g = Gravity acceleration i.e. 9.81 m/s2 

 

3.4.2 Mean Annual Energy 

The mean annual energy estimated on the basis of available mean monthly 

flows by using the following formula. 

 

Ε =
η × g × Q × H × t

1000
 

Where 

E = mean annual energy in GWh/annum 

Q = average design discharge (m3/s) and 

t = time in hour 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

Figure 3.4 Flow Chart of SIMAHPP 

  

(3.2) 
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3.5 COMPUTATION OF ENERGY OUTPUT 

A methodology was developed to compute installed power and energy 

generation using Microsoft Excel. Computation for energy output was carried out by 

considering the two alternatives. 

 Project working as peaking system in combination with continuous system. 

 Project working as continuous system.  

 

3.5.1 Peaking System 

Following steps were taken for computation of energy assuming Nasirabad 

hydropower project working for fixed peaking duration i.e. for 4 hours in combination 

with 20 hours off-peaking operation. Refer to Tables 4.4 & 4.7. 

1. Average monthly flows were used for computation 

2. Average monthly flow values were converted to volume available in 24 hours as: 

V = Q × 24 × 60 × 60 𝑚3 

3. All selected units were assumed to run in peak hours according to the design 

capacity 

4. Volume required in peak hours was found out as 

Vp =  Qd × 4 × 60 × 60 𝑚3 

5. Volume available for operation during off-peak hours was found out as, 

Vop = V − Vp 

6. Vop was converted to discharge available in off-peak hours as, 

Qop = Vop ∕ (20 × 60 × 60) 

 

7. Computed power produced for both peak hours and off-peak hours as 

Pp =
η × g × Q × H

1000
 MW 

 

Pop =
η × g × Q × H

1000
 MW 
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Where 

Pp= Peak Power 

Pop= Off-peak Power 

Q = Average monthly available flow data (m3/s) 

H = Net head (meters) 

 = Combined efficiencies of turbine, generator, transformer = 0.925 

g = Acceleration due to gravity i.e. 9.81 m/ s2 

8. Determined peak energy and off-peak energy generation as, 

Peak Energy = (Pp in MW × no. of days × 4) ∕ 1000 

       OffPeak Energy = (Pop in MW × no. of days × 20) ∕ 1000 

Where energy is in GWh 

9. Annual energy was computed as the sum of average monthly peak and off-

peak energy 

10. Plant factor was computed as 

P. F = (Annual Energy × 100)∕(8.76 ×Installed Capacity) 

 

3.5.2 Continuous System 

Following steps were taken for computation of energy assuming Nasirabad 

hydropower project working for 24 hours operation as a continuous system. Refer to 

Tables 4.5 & 4.8. 

1. Average monthly flows were selected for computation of energy 

2. Determined net head 

3. Average monthly discharge values were used as available flows (Qa) 

4. Selected number of turbines (N) depending upon available flows and design 

discharge for each unit according to the following criteria 
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If 
Qa

N
≥ Qunit then provide Qunit otherwise 

Qa

N
 

If Qa ≤ Qunit then provide Qa otherwise 
Qa

N
  

If 
Qa

2
≤ Qunit then provide 

Qa

2
otherwise 

Qa

N
 

If 
Qa

3
≤ Qunit then provide 

Qa

3
otherwise 

Qa

N
 

If 
Qa

4
≤ Qunit then provide 

Qa

4
otherwise 

Qa

N
 

Where 

Qa= Available flows 

N= Number of Turbines 

Qunit= Design discharge for one unit i.e.42 m3/sec 

5. Determined monthly energy generation as under, 

E = ∑ (
 × g × Qi × H × no. of days × 24

1000
) 

Where 

i = 1 to N 

E = Monthly Energy (GWh) 

 = Combined efficiency of turbine, generator and transformer 

g = Acceleration due to gravity (9.81m2/sec) 

Q = Available discharge (m3/sec) 

H = Net head (meters) 

6. Annual energy was computed as the sum of monthly energy generation values 

7. Determined Peak energy and off-peak energy generation as, 

Peak Energy =
(Energy in GWh × 4)

24
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0ff − Peak Energy =
(Energy in GWh × 20)

24
 

8. Plant factor was computed as, 

P. F = (Annual Energy × 100)∕(8.76 ×Installed Capacity) 

 

3.6 STORAGE COMPUTATION FOR PEAKING OPERATION 

The elevation-volume-area relationship for a reservoir indicates the variations 

of volume and surface area with elevation. From the contour map of the reservoir 

area, this relationship can be obtained. The elevation can be found out by topographic 

survey at haphazard positions. Larger intervals of contours depict a gently sloping flat 

valley area and closely spaced contours show steeply sloping cliff sides (Tariq, 2008). 

 

In this study, Capacity required for storing the flows for peaking hours 

operation with respect to elevations was computed from Elevation-Area-Volume 

relationship. Refer to Table 4.9. To compute the required storage for peaking 

operation, surface area was measured for each contour. The volume between two 

successive contours was determined as: 

 

∆V =
(A1+A2)

2
 × ∆h   (3.3) 

Where 

Δh = contour interval 

Total volume at any elevation is obtained by adding successive incremental volume as 

V = Σ∆V      (3.4) 

The data points were plotted with volume or area on x-axis and elevation on y-

axis, and area on secondary x-axis to draw Area-Elevation capacity curve. Refer to 

Figure 4.10. Contours for proposed reservoir area with required capacity were drawn 
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with the help of AutoCAD. Refer to Figure 4.11. Grid spacing was located at an 

interval of 50m on contour map of the reservoir area. Contour map of site Nasirabad 

is shown in Figure 3.5. 

 

 

 

 

 

 

 

 

 

 

Figure 3.5 Contour Map of Site Area 

 

After considering the bed level of the river or datum, contours were drawn at 

an interval of 2 meters at a suitable scale. Contours were drawn up to the maximum 

elevation level where required storage was achieved. Plan and sections of proposed 

reservoir area were also drawn for the site area. Refer to Figures 4.11, 4.12 & 4.13. 
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Chapter IV 

RESULTS AND DISCUSSION 

 

Nasirabad hydropower project was identified by WAPDA as a continuous run 

of river project. This study was carried out to maximize the energy output of project 

working as a peaking plant. Comparison of two studies with different alternatives was 

carried out on the basis of energy revenue and different number of turbines. Finally, 

project was optimized with increased design discharge and increased number of 

turbines working as a peaking plant in combination with continuous plant generating 

more revenue annually.  

 

4.1 POWER AND ENERGY GENERATION 

4.1.1 SIMAHPP Results 

After the flow, head and economic data was entered in SIMAHPP, SIMAHPP 

was simulated considering the Nasirabad project as a peaking and continuous plant 

respectively. Results were obtained in the form of tables and graphs. Combined output 

annual energy for peaking and continuous operation was 235.15 GWh at 42.37 m3/sec 

of flow with 92-% of turbine efficiency. For 4 hours operation, peak energy was 39.19 

GWh and off-peak energy was 195.96 GW for 20 hours operation. (Tables 4.1 & 4.2). 

Flow 42.37 m3/sec was selected at 90-% availability throughout the year because 

minimum flow conditions decide the maximum capacity of plant. Combined Annual 

Energy Revenue for both peak and continuous operation was 1120.91 Million Rupees 

on the basis of cost introduced for peak and off-peak hours. Installed power for this 

design discharge was 29.83 MW. SIMAHPP generated all these results considering 

only one unit of turbine. It did not give information about number of turbines. 

SIMAHPP integrated a model for sensitivity analysis. It showed how the calculated 
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cost values were sensitive to the chosen parameters head and flow (Tables 4.1, 4.2 & 

4.3). 

Table 4.1 Peaking Operation (4 Hours) 

 

Table 4.2 Continuous Operation (20 Hours) 

 

 

For continuous system, design time of operation was considered 24 hours. SIMAHPP 

was simulated again with all the same input data. (Table 4.3) In this case, annual 

energy generated was 235.16 GWh. A breakdown of total annual energy into annual 

Serial 

No. 

Time 

(%) 

Discharge 

(m³/sec) 

Efficiency 

(%) 

Power 

(MW) 

Energy 

Production 

(GWh/Year) 

Energy 

Revenue 

(Million 

Rupees/Year) 

1 10 1008.03 92 709.62 103.60 683.79 

2 20 984.19 92 692.84 202.31 1335.23 

3 30 523.13 92 368.27 161.30 1064.58 

4 40 436.4 92 307.21 179.41 1184.11 

5 50 133.48 92 93.97 68.59 452.72 

6 60 66.82 92 47.04 41.21 271.96 

7 70 50.81 92 35.77 36.56 241.27 

8 80 49.29 92 34.70 40.53 267.48 

9 90 42.37 92 29.83 39.19 258.67 

10 100 36.13 92 25.43 37.13 245.08 

Serial 

No. 

 
Discharge 

(m³/sec) 

Efficiency 

(%) 

Power 

(MW) 

Energy 

Production 

(GWh/Year) 

Energy 

Revenue 

(Million 

Rupees/Year) 

Time 

(%) 

 

1 10 1008.03 92 709.62 518.02 2279.29 

2 20 984.19 92 692.84 1011.54 4450.78 

3 30 523.13 92 368.27 806.50 3548.61 

4 40 436.4 92 307.21 897.05 3947.04 

5 50 133.48 92 93.97 342.97 1509.08 

6 60 66.82 92 47.04 206.03 906.54 

7 70 50.81 92 35.77 182.78 804.22 

8 80 49.29 92 34.70 202.64 891.61 

9 90 42.37 92 29.83 195.96 862.24 

10 100 36.13 92 25.43 185.67 816.95 
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peak energy was 39.19 GWh and off-peak energy was 195.96 GWh. Energy revenue 

for continuous system was 1034.69 million rupees. 

 

Table 4.3 Continuous Operation (24 Hours) 

 

 

The results for both alternatives were almost same in terms of annual energy 

produced for one unit of turbine. But energy revenue for 4 hours operation in 

combination with 20 hours operation (peaking plant) was more than the revenue of 24 

hours operation (continuous plant). In this case, additional 86.22 million rupees 

energy revenue can be generated. So, project was selected as a peaking plant working 

for 4 hours peak operation in combination with continuous system for 20 off-peak 

hours operation. At this point, 2nd alternative of 24 hours operation as a continuous 

system was dropped on the basis of revenue. Plant factor for both alternatives was 90 

percent. 

 

 

4.1.2 Graphs for FDC and Energy Produced 

 Graphs for site Nasirabad were self-generated in this software. Graphical 

outputs include: 

Serial 

No. 

Time 

(%) 

Discharge 

(m³/sec) 

Efficiency 

(%) 

Power 

(MW) 

Energy 

Production 

(GWh/Year) 

Energy 

Revenue 

(Million 

Rupees/Year) 

1 10 1008.03 92 709.62 621.63 2735.15 

2 20 984.19 92 692.84 1213.85 5340.93 

3 30 523.13 92 368.27 967.80 4258.33 

4 40 436.4 92 307.21 1076.47 4736.45 

5 50 133.48 92 93.97 411.57 1810.90 

6 60 66.82 92 47.04 247.24 1087.84 

7 70 50.81 92 35.77 219.33 965.06 

8 80 49.29 92 34.70 243.17 1069.93 

9 90 42.37 92 29.83 235.16 1034.69 

10 100 36.13 92 25.43 222.80 980.34 
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 Flow hydrographs 

 Flow duration curve (FDC) 

 Power & Energy duration curves 

 

Flow Duration Curve was drawn using available monthly flows for an average 

year. Refer Figure 4.1. The maximum and minimum flows available throughout the 

year can be obtained by the flow duration curve. For this project, optimum design 

discharge was selected at 90-% time availability of flow i.e. 42.37 m³/sec. This curve 

showed that minimum available flows were 36.13 m³/sec throughout the year. 

 

 

Figure 4.1 Flow Duration Curve (Mean Monthly Flows 1966-2004) 

 

A hydrograph was drawn between mean monthly flow data of Nasirabad 

hydropower project for one-year time period. Refer Figure 4.2. This graph was 

representing the overall trend of flows throughout the year. In this graph, it can be 

seen that sufficient flows were available for 40-% of the time throughout the year.  
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Figure 4.2 Hydrograph for Mean Monthly Flows (1966-2004) 

 

Figure 4.3 Power Produced for Peaking and Continuous system (One Unit) 

 

Power generated curve was drawn between the percentage time of the year and 

energy produced throughout the year. Refer to Figures 4.3 & 4.4. Power and energy 

production values were selected against 90-% time of the year. The purpose for 

selecting the energy at 90-% availability of time was to provide energy for maximum 
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time of the year. Power generated curve was also called Load Duration curve. This 

curve was demonstrating the total power available at the site. When the power-

probability chart was examined, it was observed that the curve was parallel to the 

flow duration curve. 

 

Figure 4.4 Energy Produced for Peaking and Continuous system (One Unit) 

 

 

As flow rate grows, the power generation will increase. A decrease in flow, 

will result a reduction in power generation. Data entered to the software was the 

average monthly flow rates (12 number of data). Therefore, calculation results 

showed that the flow rates vary gradually for whole year. This was the reason that 

flow duration and power probability graphs were plotted as variable lines, changing 

throughout the year.  

 

 

Graphs drawn for flow hydrograph, flow duration curve and power and energy 

duration curve showed the same trend for peaking as well as continuous system. 
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4.1.3 Energy Computation 

A spreadsheet model was also prepared to compute power and energy of 

Nasirabad hydropower project considering the project as a peaking plant as well as 

continuous plant for one unit of turbine. Refer to Table 4.4 & 4.5 for peaking and 

continuous system respectively. 

 

4.1.3.1 Peaking Operation 

Mean monthly flows were taken for this purpose. Against each average 

monthly flow, peak and off-peak volume was computed. After this, daily and monthly 

power in MW and energy in GWh was calculated respectively. (Table 4.4). Optimum 

design discharge 42 m³/sec was taken from the flow duration curve at 90-% 

availability of time. Refer to Figure 4.1. Total installed power was 30 megawatts. 

Annual energy computed through spreadsheet model was 255.74 GWh. Total peak 

energy computed was 43 GWh and total off-peak energy was 212 GWh. (Figure 4.5).  

Plant factor of project was 98.18-%. Energy revenue computed was 1106 million 

rupees annually on the basis of assumed cost of Rs.6/ KWh for peak hours and Rs. 

4/KWh for off-peak energy. 

 

 

Figure 4.5 Peak and Off-Peak Energy (one-unit Peaking Operation) 
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4.1.3.2  Continuous Operation 

Computations were carried out by considering the project as continuous plant. 

(Table 4.5). Installed power was 29.73 MW in this case. Annual energy generation 

was 250.65 GWh. Peak energy generated was 41.78 GWh and off-peak energy 

generation was 208.88 GWh considering one unit of turbine. (Figure 4.6). Plant factor 

of project was 98.76%. In this case, energy revenue computed was 1086.20 million 

rupees annually.  

 

 

Figure 4.6 Peak and Off-Peak Energy (one-unit Continuous Operation) 

 

Using this methodology, results of both alternatives were compared. From 

comparison, it was found that annual energy generation for both alternatives was 

almost same including peak and off-peak energy. Plant factor for both alternatives 

showed that sufficient flows were available throughout the year to run hydropower 

plant using one unit of turbine. 
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Time     Power       Daily Energy    Monthly Energy

Month  Qinflow Qpower Total     Peak  Off-Peak   Peak Off-Peak     Peak  Off-Peak     Peak  Off-Peak Day Peak Off-Peak Total

  m
3
/s   m

3
/s m

3
/day m

3
m

3
hrs hrs MW MW GWh GWh GWh GWh GWh

JAN 42.37 42.00 3,628,800 604,800 3,024,000 4.00 20.00 30 30 0.12 0.59 31 3.69 18.44 22.12

FEB 38.56 38.56 3,331,584 604,800 2,726,784 4.00 20.00 30 27 0.12 0.54 28 3.33 15.01 18.34

MAR 36.13 36.13 3,121,632 604,800 2,516,832 4.00 20.00 30 25 0.12 0.49 31 3.69 15.34 19.03

APR 50.81 42.00 3,628,800 604,800 3,024,000 4.00 20.00 30 30 0.12 0.59 30 3.57 17.84 21.41

MAY 154.99 42.00 3,628,800 604,800 3,024,000 4.00 20.00 30 30 0.12 0.59 31 3.69 18.44 22.12

JUN 523.13 42.00 3,628,800 604,800 3,024,000 4.00 20.00 30 30 0.12 0.59 30 3.57 17.84 21.41

JUL 1008.03 42.00 3,628,800 604,800 3,024,000 4.00 20.00 30 30 0.12 0.59 31 3.69 18.44 22.12

AUG 984.19 42.00 3,628,800 604,800 3,024,000 4.00 20.00 30 30 0.12 0.59 31 3.69 18.44 22.12

SEP 436.40 42.00 3,628,800 604,800 3,024,000 4.00 20.00 30 30 0.12 0.59 30 3.57 17.84 21.41

OCT 133.48 42.00 3,628,800 604,800 3,024,000 4.00 20.00 30 30 0.12 0.59 31 3.69 18.44 22.12

NOV 66.82 42.00 3,628,800 604,800 3,024,000 4.00 20.00 30 30 0.12 0.59 30 3.57 17.84 21.41

DEC 49.29 42.00 3,628,800 604,800 3,024,000 4.00 20.00 30 30 0.12 0.59 31 3.69 18.44 22.12

255.74

98.18Plant Factor 

Annual Energy

Discharge Volume

Table 4.4 Combined Peaking & Continuous Operation (1 Unit) 
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Table 4.5 Continuous Operation (1 Unit) 

PERIOD
NET

HEAD

Q1 hT1 Energy1 Total Energy Peak Energy Off-Peak Energy

months (days) (m
3
/s) (m) (m

3
/s) (%) (GWh) (GWh) (GWh) (GWh)

1 31 42.37 78.0 42.00 92.5% 21.68 21.68 3.61 18.07

2 28 38.56 78.0 38.56 92.5% 17.98 17.98 3.00 14.98

3 31 36.13 78.0 36.13 92.5% 18.65 18.65 3.11 15.54

4 30 50.81 78.0 42.00 92.5% 20.98 20.98 3.50 17.49

5 31 154.99 78.0 42.00 92.5% 21.68 21.68 3.61 18.07

6 30 523.13 78.0 42.00 92.5% 20.98 20.98 3.50 17.49

7 31 1008.03 78.0 42.00 92.5% 21.68 21.68 3.61 18.07

8 31 984.19 78.0 42.00 92.5% 21.68 21.68 3.61 18.07

9 30 436.40 78.0 42.00 92.5% 20.98 20.98 3.50 17.49

10 31 133.48 78.0 42.00 92.5% 21.68 21.68 3.61 18.07

11 30 66.82 78.0 42.00 92.5% 20.98 20.98 3.50 17.49

12 31 49.29 78.0 42.00 92.5% 21.68 21.68 3.61 18.07

= 250.65 41.78 208.88

= 96.23

MEAN ANNUAL ENERGY  (GWh)

AVAILABLE 

FLOW

MEAN MONTHLY

ENERGY

     PLANT FACTOR                                                                 

TIME TURBINE - 1



49 
 

But more revenue can be generated by considering the project as a peaking 

plant because cost per kilo watt hour is higher in peak hours as compared to low cost 

off-peak power produced in continuous system. So, continuous system was dropped 

on the basis of energy revenue. 

 

4.2 COMPARISON OF BOTH STUDIES 

Results produced by spreadsheet model were compared with results of 

software SIMAHPP. In this comparison, project working as a peaking plant was 

considered only dropping the 2nd alternative of continuous system on the basis of 

revenue generated. Comparison is shown in Table 4.6. This table shows that there 

were some minor deviations with the parameters set by spreadsheet model. The 

overlap rate of parameters obtained from two studies ranges from 0.99 to 1.09. These 

differences were of minor nature based on two different calculation methods. 

Table 4.6 Comparison of Two Studies 

 
Parameters 

 Spreadsheet Model SIMAHPP Overlap Ratio 

Operation  

Peaking (4 Hours 

peaking + 20 hours 

continuous) 

Peaking (4 Hours 

peaking + 20 hours 

continuous) 

- 

Installed Power  30 (MW) 29.83 (MW) 1.01 

Energy production  255.74 (GWh) 235.16 (GWh) 1.09 

Net Head  78 (m) 78 (m) 1.0 

Design Discharge  42 (m³/sec) 42.37 (m³/sec) 0.99 

No. of units 1 1 - 
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4.3 OPTIMIZATION OF NASIRABAD HYDROPOWER PROJECT 

Out of two alternatives peaking and continuous operation, peaking operation 

was generating more revenue than continuous operation in both studies with one unit. 

To optimize the energy output of project, it was considered to increase the design 

discharge from 90% availability to 49% availability of the time throughout the year to 

compensate the local demand of energy during peak hours in winter season. For this 

purpose, spreadsheet model was utilized to optimize the energy output of project by 

increasing the design discharge with increased number of turbines due to availability 

of sufficient flows. As SIMAHPP does not give information about multiple turbines, 

optimized energy output was determined by spreadsheet model only. Annual energy 

generation of project as peaking operation was 645.80 GWh at a plant factor of 

61.98% (Table 4.7).  

 

By storing certain amount of available flows in off-peak hours to utilize it later in 

peak hours, energy output of Nasirabad hydropower project can be enhanced. For this 

purpose, design discharge of 168 m³/sec was taken with four units considering the 

system working as daily peaking throughout the year (Figure 4.7). 

Figure 4.7 Average Monthly Inflows
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The purpose was to get maximum benefits in terms of energy as well as 

generating more revenue. Energy output was computed for both alternatives peaking 

as well as continuous system with four units of turbines. The design discharge for 

each unit was taken 42 m3/sec. Installed power was 119 MW. Total energy generation 

during peak hours was 174 GWh and total energy generation during off-peak hours 

was 472 GWh (Figure 4.8). 

 

 

Figure 4.8 Peak and Off-Peak Energy (4 Unit Peaking Operation) 

 

 

 In case of continuous operation for 24 hours, power produced for 4 turbines 

was 118.94 MW. Annual energy output was 649.51 GWh. Peak energy produced was 

108.25 GWh and off-peak energy production was 541.25 GWh. (Table 4.8 & Figure 

4.9). On comparing the annual energy by considering both alternatives, it was found 

that total annual energy produced by both alternatives was almost same. But peak 

energy produced in peaking system was more than the peak energy produced during 

continuous system. So, continuous system as a second alternative was dropped off. 

Energy revenue computed in case of continuous system was 2814.50 million rupees 
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(108.25 X 6 + 541.25 X 4) and with peaking operation 2932 million rupees (174 X 6 

+ 472 X 4) giving us additional 117.50 million rupees annually. The turbine 

efficiencies were taken constant i.e.92.55 % and the net head was also fixed i.e. 78 

meters. All units are suggested to run in peak hours throughout the year whereas in 

off-peak hours, 1,2 or 3 units will be operated according to the discharge available 

after peaking operation. 

 

 

Figure 4.9  Peak and Off-Peak Energy (4 Unit Continuous Operation) 

 

4.4 STORAGE COMPUTATION (AREA-ELEVATION RELATIONSHIP) 

 To run the all the turbines in 4 peak hours daily, required storage computed as 

follows: 

 Design discharge of 168 m³/sec maintained for four hours to run four turbines 

at a time during peaking operation. Thus, volume required to create reservoir 

upstream of the weir for peak operation was as follows: 

No. of turbines (for peak hours) = 4 

Design discharge for one unit (Qunit) = 42 m³/sec 

Total Design discharge (Qd) =168 m³/sec 
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Required Peak Volume = 168 × 4 × 60 × 60 

 =2419200 m³ 

 = 2.42 Million m³ 

 

This required amount of water stored in 20 off-peak hours was computed with 

respect to elevation by using Area-Elevation relationship. (Table 4.9). Storage 2.80 

million m3 was computed at elevation 2046 meters which was almost equal to 

required storage. Additional storage 0.38 million m3 greater than the required storage 

(=2.80-2.42=0.38 million m3) was occupied by assumed value of free board. 

Elevation 2046 meters was also taken as normal conservation level determined from 

the elevation-volume relationship curve (Figure 4.10).  

 

Figure 4.10 Volume-Elevation-Area Curve 

 

The reservoir level corresponding to normal reservoir storage is called as 

normal conservation level (N.C.L). From Area-Volume relationship, following 

information was also obtained. 
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Table 4.7 Combined Peaking & Continuous Operation (4 units) 

Time     Power       Daily Energy    Monthly Energy

Month  Qinflow Qpower Total     Peak  Off-Peak   Peak Off-Peak    Peak  Off-Peak     Peak  Off-Peak Day Peak Off-Peak Total

  m
3
/s   m

3
/s m

3
/day m

3
m

3
hrs hrs MW MW GWh GWh GWh GWh GWh

JAN 42.37 42.37 3,660,768 2,419,200 1,241,568 4.00 20.00 119 12 0.48 0.24 31 14.75 7.57 22.32

FEB 38.56 38.56 3,331,584 2,419,200 912,384 4.00 20.00 119 9 0.48 0.18 28 13.32 5.02 18.34

MAR 36.13 36.13 3,121,632 2,419,200 702,432 4.00 20.00 119 7 0.48 0.14 31 14.75 4.28 19.03

APR 50.81 50.81 4,389,984 2,419,200 1,970,784 4.00 20.00 119 19 0.48 0.39 30 14.27 11.63 25.90

MAY 154.99 154.99 13,391,136 2,419,200 10,971,936 4.00 20.00 119 108 0.48 2.16 31 14.75 66.89 81.64

JUN 523.13 168.00 14,515,200 2,419,200 12,096,000 4.00 20.00 119 119 0.48 2.38 30 14.27 71.36 85.63

JUL 1008.03 168.00 14,515,200 2,419,200 12,096,000 4.00 20.00 119 119 0.48 2.38 31 14.75 73.74 88.49

AUG 984.19 168.00 14,515,200 2,419,200 12,096,000 4.00 20.00 119 119 0.48 2.38 31 14.75 73.74 88.49

SEP 436.40 168.00 14,515,200 2,419,200 12,096,000 4.00 20.00 119 119 0.48 2.38 30 14.27 71.36 85.63

OCT 133.48 133.48 11,532,672 2,419,200 9,113,472 4.00 20.00 119 90 0.48 1.79 31 14.75 55.56 70.31

NOV 66.82 66.82 5,773,248 2,419,200 3,354,048 4.00 20.00 119 33 0.48 0.66 30 14.27 19.79 34.06

DEC 49.29 49.29 4,258,656 2,419,200 1,839,456 4.00 20.00 119 18 0.48 0.36 31 14.75 11.21 25.96

645.80

62.0

Annual Energy

Plant Factor

Discharge Volume
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Table 4.8 Continuous Operation (4 units) 

 

PERIOD
NET

HEAD

Q1 hT1 Energy1 Q2 hT2 Energy2 Q3 hT3 Energy3 Q4 hT4 Energy4 Total Energy Peak Energy Off-Peak Energy

months (days) (m
3
/s) (m) (m

3
/s) (%) (GWh) (m

3
/s) (%) (GWh) (m

3
/s) (%) (GWh) (m

3
/s) (%) (GWh) (GWh) (GWh) (GWh)

1 31 42.37 78.0 21.19 92.5% 11.16 21.19 92.5% 11.16 0.00 92.5% 0.00 0.00 92.5% 0.00 22.32 3.72 18.60

2 28 38.56 78.0 38.56 92.5% 18.34 0.00 92.5% 0.00 0.00 92.5% 0.00 0.00 92.5% 0.00 18.34 3.06 15.29

3 31 36.13 78.0 36.13 92.5% 19.03 0.00 92.5% 0.00 0.00 92.5% 0.00 0.00 92.5% 0.00 19.03 3.17 15.86

4 30 50.81 78.0 25.41 92.5% 12.95 25.41 92.5% 12.95 0.00 92.5% 0.00 0.00 92.5% 0.00 25.90 4.32 21.58

5 31 154.99 78.0 38.75 92.5% 20.41 38.75 92.5% 20.41 38.75 92.5% 20.41 38.75 92.5% 20.41 81.64 13.61 68.03

6 30 523.13 78.0 42.00 92.5% 21.41 42.00 92.5% 21.41 42.00 92.5% 21.41 42.00 92.5% 21.41 85.63 14.27 71.36

7 31 1008.03 78.0 42.00 92.5% 22.12 42.00 92.5% 22.12 42.00 94.4% 22.57 42.00 94.4% 22.57 89.39 14.90 74.49

8 31 984.19 78.0 42.00 92.5% 22.12 42.00 92.5% 22.12 42.00 94.4% 22.57 42.00 94.4% 22.57 89.39 14.90 74.49

9 30 436.40 78.0 42.00 92.5% 21.41 42.00 92.5% 21.41 42.00 94.4% 21.84 42.00 94.4% 21.84 86.50 14.42 72.09

10 31 133.48 78.0 33.37 92.5% 17.58 33.37 92.5% 17.58 33.37 95.1% 18.07 33.37 95.1% 18.07 71.30 11.88 59.42

11 30 66.82 78.0 33.41 92.5% 17.03 33.41 95.1% 17.51 0.00 0.0% 0.00 0.00 0.0% 0.00 34.54 5.76 28.79

12 31 49.29 78.0 24.65 92.5% 12.98 24.65 89.4% 12.54 0.00 0.0% 0.00 0.00 0.0% 0.00 25.52 4.25 21.27

= 649.51 108.25 541.25

= 62.34

MEAN ANNUAL ENERGY  (GWh)

PLANT FACTOR

TURBINE - 2 TURBINE - 3 TURBINE - 4AVAILABL

E FLOW

MEAN MONTHLY

ENERGY
TIME TURBINE - 1
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Table 4.9 Area-Volume Relationship 

 

Proposed reservoir area for required storage was marked by drawing 

contour map of the project area with the help of AutoCAD. 

Suggested Reservoir Storage at Elevation 2046 m = 2842500 m³ 

      =2.84 Million m³ 

Minimum Bed Level at Weir Site = 2030 m 

Normal Conservation Level for 2.8 Mm³ = 2046 m 

Maximum Reservoir Depth   = 2046 – 2030 

   = 16 m 

Free Board (Assumption)   = 4 m 

Total Proposed Weir Height     =16 + 4 = 20 m 

Proposed Weir Crest Level      =2030+20 

 =2050 meters 

Elev. 

(m) 

Ht. Above 

Datum 

(m) 

Map Area 

(m²) 

Plan Area 

(Hectares) 

Incr.Vol. 

(Hec-m) 

Total 

Capacity 

(Hec-m) 

Total 

Capacity 

(Million 

m³) 

2032 2 0 0.00 0 0 0.00 

2034 4 44340 4.43 4.43 4.43 0.04 

2036 6 126105 12.61 17.04 21.48 0.21 

2038 8 172562 17.26 29.87 51.35 0.51 

2040 10 228871 22.89 40.14 91.49 0.91 

2042 12 289071 28.91 51.79 143.28 1.43 

2044 14 356483 35.65 64.56 207.84 2.08 

2046 16 407660 40.77 76.41 284.25 2.84 

2048 18 494274 49.43 90.19 374.45 3.74 

2050 20 585303 58.53 107.96 482.40 4.82 
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Figure 4.11 Reservoir Area (Plan)
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    Figure 4.12 Section A-A  

Figure 4.13 Section B-B 

N.C.L 
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 First of all, bed level of the river was selected i.e. 2030 meters. Contours were 

drawn on AutoCAD with an interval of 2 meters from the bed level. After drawing the 

contours, surface area for each contour was measured. 

 

In Figure 4.11, plan of proposed reservoir area is shown. All the contours were 

closed lines within the reservoir area. This figure shows the possible location of a 

reservoir at elevation 2046 meters providing the volume almost equal to required 

volume i.e. 2.8 million m3 and the area in which volume of water to be confined. 

Section A-A & B-B were cut to show the clear picture of reservoir area with different 

elevations (Figures 4.12 & 4.13). 

.
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Chapter V 

CONCLUSIONS AND RECOMMENDATIONS 

 

5.1 CONCLUSIONS  

In this study, it has been decided that the proposed hydel scheme on Hunza 

River is technically feasible and relatively easy to construct due to available 

infrastructure and geological conditions in this reach of Hunza River. 

 

From the daily discharge data, project is optimized at optimum design 

discharge of 168 m³/sec for 49% time of the year. Power generated will be 119 MW 

with four number of turbines. Total annual energy determined in this study is 645.80 

GWh in case of peaking as well as continuous operation which will be utilized to 

mitigate the local power demand in Nasirabad during winter season. Whereas, 

WAPDA identified this project at 26 m³/sec at 95% availability of the year with two 

number of turbines generating 133.61 GWh energy with installed capacity of 15 MW.  

 

 

For the selected optimum design discharge i.e.168 m³/sec for four turbines, a 

storage reservoir of 2.84 Million m³ is suggested to run this project on peaking as a 

run of river project and space is available upstream of the weir for this storage 

reservoir. Francis turbine is suggested for this project. Water will be stored in off-

peak hours in reservoir and will be utilized in peak hours. In this way, more revenue 

will be generated as cheap energy will be produced in peak hours instead of thermal 

energy. Additional 65.75 GWh (61%) energy is produced in suggested peaking 

system operation generating additional revenue of 117.50 Million rupees in 

comparison with continuous system operation. 
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5.2 RECOMMENDATIONS 

 Nasirabad hydropower project is recommended to be designed as a peaking 

power project with partial off-peak power generation as well. 

 

 Some storage should be developed upstream of the weir to store the flows 

required in peak hours for energy generation 

 

 Similar study should be done in detailed investigation and design of other 

hydropower projects 

 

 New version of this software SIMAHPP 5 should be utilized for further 

studies. Along with other additions, it simulates for multiple units and also 

gives information about material and sizing of penstock 
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A-1 DATA ENTRY STEPS 

A-1.1 Open Project 

To open the new project in SIMAHPP, click file from the file menu 

File → Open New Project 

By clicking at new project, fivesites.spr file opens. Other particulars of the project file 

can be viewed from the project information. Figure No.1 explains how to open the 

new project and also shows how to open file in SIMAHPP. 

 

Figure No.1 Open Project 

A-1.2 View Options 

By clicking at ‘Options’ tab, another window of ‘Hydropower Site 

Information’ opens. 

Click Options → Hydropower Site Information 

Here the choice is given for selecting the multiple sites. By clicking at dropdown box 

of number of hydropower sites, one can select the required number of sites. Site 

names can also be changed by double clicking at given site ID. Then against each site 

ID, type of available flow data is entered whether it is daily mean flow, monthly mean 
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flow or annual mean flow. After available flow data is entered, required entry for each 

type of flow data is also edited e.g. for daily mean flow data, required entry is 365. 

For mean monthly flow, required entry is 12 and for annual mean flow, required entry 

is only 1. Default unit system is also presented in this window. For flow and length, 

units are cubic meter per second (m³/sec) and meter (m) respectively. Currency units 

can also be changed by clicking at drop down box in the same window. Options 

window screen can be seen and Hydropower Site Information screen is shown in 

Figure No.2 & Figure No.3 

Figure No.2 Options 
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Figure No.3 Hydropower Site Information 

A-1.3 Open Flow Data 

By clicking at the parameters tab, submenu screen appears. At this screen, 

click on flow data as shown in figure No.4. Here another screen appears in which 

flow data is entered for required number of sites. 

Figure No.4 Parameters 

Mean monthly flow data for project site was entered at site ID Site 102 in 

12 entries as shown in Figure No.5. Similarly, mean daily and mean annual flow data 
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were entered at site ID Site 101 in 365 entries, and site 103 in only 1 entry 

respectively. 

Figure No.5 Flow Data 

A-1.4 Head and Financial Parameters 

After entering flow data, go to the parameters tab, click head and financial 

data tab in submenu. Design and cost parameters including gross head, tail water 

level, cost of electricity per kwh, operation hours per day depending on the 

availability of flow per day, inflation rate, value added tax and other taxes values are 

entered here. All these values are entered for required number of sites. Parameters 

entry screen is shown in Figure No.6. 

A-1.5 Run SIMAHPP 

After input of all required data, click at Run Simulator tab. Simulator 

Windows get loaded. After this, results can be viewed. This window shows results for 

all sites in tabular and graphical format after simulation. Results of each site can also 

be viewed individually by checking at a tab where the site names are represented. 

Simulator window screen id displayed in Figure No.7. 
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. 

 

Figure No.6 Head and Financial Parameters 

 

Figure No.7 Run Simulator 
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A-1.6 Results 

By clicking at the view results tab, a table of project characteristics appears in 

which results of all sites is summarized. 

View Results → Project Characteristics 

From this tab, graphical output can also be viewed here. The names of the sites used 

in the simulation are also listed under the submenu of the View Results Tab. 

Flow Hydrograph and FDC can be viewed as: 

View Results → Flow Hydrograph and FDC → Site ID 

Power duration and energy optimization curve can be viewed as: 

View Results → Power and Energy Curves → Site ID 

Figure No.8 represents how results can be seen in SIMAHPP. 

 

 

Figure No.8 View Results 
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A-1.7 Graphs 

By clicking at the compare tab, graphical outputs are displayed. Comparison 

of the characteristics of individual sites is represented here in terms of graphs. Such as 

through the design flow and optimum operation time in a year, power and energy 

production, investment costs and energy revenue and other economic parameters. 

Correlation of all characteristics is displayed in the submenu of the compare tab. 

Graphical outputs in terms of comparison can be seen as shown in Figure No.9. 

Figure No.9 View Graphs 

Comparison of design flow and optimum operation time in a year can be viewed in 

terms of graph: 

Compare → by design flow 

Comparison for power and energy production: 

Compare → by power generated or click at the dropdown box of view graphs at the 

top right of the screen 

Comparison for investment costs and energy revenues: 

Compare → by costs and revenues or click at the dropdown box of view graphs at the 

top right of the screen 
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Comparison for costs and capacity installed: 

Compare → by costs per capacity or click at the dropdown box of view graphs at the 

top right of the screen 

Comparison for payback periods and amortization rates: 

Compare → by payback periods or click at the dropdown box of view graphs at the 

top right of the screen 

Comparison for carbon emission reductions (kg co2/kwh) 

Compare → by emission reduction or click at the dropdown box of view graphs at the 

top right of the screen. 

 

A-1.8 Format Graphical Outputs 

If it is desired to change the type of chart or graph, it can be done by clicking 

at the format tab. 

Format → Chart Type 

Similarly, graph colors can also be changed by clicking at the same format tab. 

Format → Chart Colors 

By choosing the chart type, all the desired changes are updated automatically by 

program. 

 

A-1.9 Edit Data 

By editing data, more simulations can be made and results can be viewed 

without leaving the simulator windows. For example, service life (in years) of the 

planned hydropower project or the turbine efficiencies for one or more sites used in 

the simulation can be changed. This can be done from the first two dropdown boxes. 

Simulation results are automatically updated by program as these changes are made. 
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Main input parameters such as the flow data, head and financial data can also be 

changed by clicking at the edit data tab of the simulator. 

The flow data can be edited: 

Edit Data → Flow Data 

Similarly, head and financial data can also be edited: 

Edit Data → Head, Financial Data 

When main input data is edited, the program will be run from the main Run Simulator 

tab without leaving the Simulator Windows.  

 

A-1.10 Save Graphs 

Graphical outputs can be saved into image files. By clicking at the file tab of 

the simulator, graphs can be saved from the submenu. 

File → Save Graphs 

Save Graphs dialog box opens with saving options. Graphs of the active site 

information as well as all graphs of all sites can be saved. Files are saved at the 

destination path shown on the save dialog.  

 

A-1.11 Printing of Results 

Results can be printed by clicking at the File tab.  

File → Print Results Grid. 

By this click, printing dialog box opens. Here are two options for one specific site i.e. 

printing for results table (upper) or printing for project characteristics table (lower). 

Results can be viewed and printed in full width by checking the option in printing 

dialog box. Prints for only one site can be printed. Results from all sites can also be 

printed from the view results tab. 

View results → project characteristics 
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And then click at the print button. Format of the table in printed form is same as seen 

on the screen or print preview. Figure No.10 represents how results and project 

characteristics can be printed. 

 

 

Figure No.10 Print Results 
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Table 1. Mean Monthly Flows (1966-2004) 
 

Month Average Flows 

Jan 42.37 

Feb 38.56 

Mar 36.13 

Apr 50.81 

May 154.99 

Jun 523.13 

Jul 1008.03 

Aug 984.19 

Sep 436.40 

Oct 133.48 

Nov 66.82 

Dec 49.29 
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Table 2. Mean Daily Flows (1966-2004) 

Date Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec 

1 47.60 43.32 37.83 29.97 65.23 266.98 871.47 1337.43 1206.46 181.35 75.31 46.34 

2 47.60 43.07 37.56 29.22 63.47 221.14 914.29 1370.17 1208.98 173.79 74.55 45.34 

3 47.60 43.32 37.29 29.72 62.46 202.00 954.59 1438.18 1181.27 166.23 73.29 44.83 

4 48.11 43.32 37.29 29.72 63.22 175.55 765.68 1478.48 1146.01 161.20 72.54 43.83 

5 47.60 43.07 37.02 29.72 64.48 187.14 743.02 1538.93 1042.74 153.64 71.78 43.32 

6 47.60 43.07 36.31 30.22 65.74 173.79 624.64 1473.44 994.89 148.60 71.03 42.57 

7 47.35 43.07 36.05 30.73 69.52 200.74 498.70 1410.47 909.25 143.57 70.52 42.06 

8 47.60 43.07 35.78 32.49 96.97 209.81 506.26 1317.28 941.99 138.53 70.27 41.05 

9 47.35 43.07 35.78 34.76 109.06 210.56 483.59 1266.91 949.55 133.49 69.52 40.80 

10 47.60 42.57 35.51 37.28 139.54 213.84 483.59 1135.93 984.81 129.71 69.26 40.30 

11 47.35 42.36 35.07 38.03 144.07 228.95 506.26 1047.78 838.73 125.94 68.76 40.05 

12 47.35 42.36 34.53 38.54 129.21 251.11 506.26 1007.48 881.55 147.34 68.51 39.29 

13 47.60 42.36 34.27 38.03 143.06 287.13 468.48 934.44 843.76 118.38 68.00 38.79 

14 47.35 42.36 34.00 37.78 162.71 355.14 483.59 876.51 675.01 114.60 67.50 38.03 

15 47.35 42.10 33.29 37.28 194.70 390.40 491.15 906.73 556.63 112.08 66.24 37.53 

16 46.60 41.83 33.02 37.02 234.24 410.55 518.85 954.59 465.96 109.56 64.98 37.02 

17 46.34 41.56 32.75 36.27 251.87 410.55 506.26 1055.34 433.22 105.79 62.72 36.52 

18 46.09 40.85 32.49 36.02 289.65 372.77 533.96 1135.93 390.40 103.27 62.21 36.27 

19 45.59 40.58 32.49 35.51 327.43 334.99 657.38 1211.49 355.14 100.75 59.69 36.02 

20 45.34 40.58 32.04 35.01 342.54 307.28 712.79 1206.46 329.95 98.23 56.92 35.77 

21 45.34 40.32 31.77 36.02 264.46 314.84 778.28 1191.35 314.84 96.97 53.90 35.51 

22 44.83 40.05 31.24 37.02 245.07 352.62 926.88 1148.53 289.65 94.45 52.89 35.01 

23 44.58 39.61 30.71 37.78 199.98 440.77 1163.64 1125.86 266.98 93.19 52.14 34.76 

24 44.08 39.34 30.71 42.06 184.62 488.63 1017.55 1211.49 251.11 90.67 52.14 37.28 

25 43.83 39.07 30.53 49.37 205.27 518.85 1264.39 1294.61 232.73 88.15 51.13 37.02 

26 43.57 38.80 30.26 67.75 183.61 599.45 1135.93 1181.27 221.65 85.64 50.88 36.52 

27 43.32 38.09 29.99 74.05 245.83 607.01 896.66 1201.42 214.59 83.12 49.87 36.02 

28 43.32 38.09 29.73 71.78 256.91 649.82 1078.00 1042.74 204.01 82.11 49.11 35.77 

29 43.57 

 

29.46 70.52 250.36 758.13 1198.90 1055.34 196.46 80.60 48.11 35.77 

30 43.32 

 

31.77 67.75 234.24 821.10 1377.73 1105.71 188.90 77.83 46.85 35.01 

31 43.07 

 

30.73 

 

238.27 

 

1428.10 1166.16 

 

76.82 

 

35.01 

      


